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Introduction

Introduction

With the release of version 7.6, Impact/SQL has introduced a new type of field for use in Master
documents called SmartTags. The SmartTag field will allow the Document Administrator to create
documents that will accommodate the new unlimited number of parties to enhanced residential and
commercial transactions. The old DDE fields are still available and will still work so there is no need to
modify any of your existing documents.

This document is intended to bridge the gap between the current Maintaining Master Documents manual
and the completely updated version to be released shortly. It will only cover the items that are new to
Impact/SQL 7.6 and/or have changed in the way you create a Master document. The Commercial and
Enhanced Residential Transactions in Impact/SQL ver 7.6 document explains the new enhancements
from the end user’s perspective so it will not be covered here in any detail.
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General Information and Helpful Hints

General Information and Helpful Hints

Some of the formatting conventions used in this manual are:
e  Keystrokes, such as the Enter key, will be displayed as ENTER in the manual.
e Any text that appears on the screen will be shown as Edit or Cancel.
e Menus and menu options you are to use will be displayed as Format >
Paragraph.... This will indicate you are to choose the Paragraph... option from the

Format pull-down menu.

» The underline indicates the keystroke you can use with the ALT key to use the keyboard
instead of the mouse. In the example above you would press ALT-O-P.

e  Textyou are to type will appear as Type This.

e Actions you are to take with the mouse will appear as CLICK.
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Overview of Changes

Overview of Changes

Impact/SQL 7.6 still uses DDE fields to bring information into the document from the database. All the
fields you had available to you in the past are still there and operational. This release will not require you
to redesign any of your existing Master documents.

New escrow files created in Impact/SQL 7.6 will start off with a designation of Commercial or Residential.
You will most likely be designing a new set of documents to be used exclusively by the commercial side
of the business as opposed to having one document to fit both needs. This does not mean you can’t
redesign your existing Masters to take advantage of the new fields.

Impact/SQL now has “parties to the file” when referring to Buyers, Sellers, Lenders, etc. Commercial files
can have an unlimited number parties. Residential files can have an unlimited number of parties except
for Lenders and Real Estate Agents being limited to three (3) apiece.

Commercial files will now handle any number of properties. The Residential files are still limited to just
one.

The SmartTags are used only in Escrow Masters as of Impact/SQL v.7.6. They will be incorporated into
Title over the next few releases. As for changes in Title, the only real change will be the End User being
prompted to pick a legal description before creating a prelim/commitment or a policy. More on this can be
found starting on page 13.

Parties to the File Fields

In previous versions of Impact/SQL, you were limited on the number of buyers, sellers, listing agents, etc.,
that could be associated with an Escrow file. Each Escrow File was also limited to one property. That
restriction has been lifted in Impact/SQL 7.6. The Initial Questions on the Edit menu shows the options
for Parties and Properties instead of Buyer/Sellers. The DDE fields used in the previous versions of
Impact/SQL are still available and still operational but there are some very important considerations to
keep in mind.

Be Aware of The Parties Position Order

If you create a User document that contains the DDE fields for the individual Buyers or Sellers, such as
<<Buyerl>>, <<Sellerl>> or <<Buyer 2 Email>>, Impact/SQL will pull in the data associated with the
matching Buyer or Seller in the Parties List. In other words, if your Escrow file has 10 Buyers and 10
Sellers, the <<Buyer1>> field will pull in the name of the first Buyer shown on the Reposition screen.

Using the scenario above, let’'s say the User document is created in the morning, printed and saved. After
lunch another employee is working with the Escrow file and discovers the list of Buyers and Sellers would
be easier to work with if they were in alphabetical order. What used to be the first Buyer in the list is now
the seventh Buyer in the list. Everyone else moved up one position. The next day the original document
created for the first Buyer is re-opened and a correction is made. However, <<Buyer1>> is no longer the
same individual. Our previous Buyer who is supposed to sign the document has been replaced even
though the document was created the day before.

» Thisis NOT an issue if SmartTags are used.

Also, as in previous versions of Impact/SQL, the vesting is linked to the buyer where it was entered and
will move with the buyer in the Position List.
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SmartTags

To handle the new features, Masters will now use SmartTags along with the DDE fields to import
information from the database. SmartTags will allow you to design your documents so all the parties in a
file are visible or just specific parties. The DDE fields that you are familiar with are still present and are
used in the same manner as previous versions of Impact/SQL.

When you view a Master that uses SmartTags, their normal appearance is identical to the DDE fields that
you have always seen. They will be inserted into the document like a DDE field and take on a bold, red
appearance—depending upon your personal settings. When you RIGHT-CLICK on one of the SmartTags
and choose Toggle Field Codes or press ALT-F9 to toggle all fields, you will see a difference in the
verbiage for a SmartTag versus a DDE field. An example of a SmartTag field is shown below:

{ DDE IMPACT SmartTag BuyerPayoff.LoanNumber.BUY1|Which Loan is being paid off? \*
charformat \t }

We’ll go into exactly what all that means a little later in this chapter.

Changes in the Insert Field Window

Insert Field The Insert Field window now contains a new SmartTag tab. You
Sellers | Buyer Payofs | Sellr payoffs | MHomes SmartTsg | 4| | will also see two navigation arrows on the far right of the tabs.
S Em 2 These allow you to scroll back and forth between the tabs
- -Ficed e changing which ones are visible. They are shown in the X]
v Fized Mame + Vesting N
- ~Emal Address red circle here. CLICK on the <« to scroll the tabs to the
v Signature above the line . H sl
oo b hm e left making the ones on the far right visible. CLick on the —

e et fhanter » to scroll the tabs to the right making the ones on the

et A | far left visible.

~Current Address City
Current Address State

| et e T_hge Es_crow mod_uIe’s Insert Field _vvindovx_/ with thg SmartTa_g tab
|- CurentHome e visible is shown in Figure 1. The first noticeable difference is the
- Current ek Extencion tree structure of the available SmartTags. The fields are shown in
[ e P nber =] groupings. The group names are listed with a + next to the name.

This indicates the group can be expanded to show available
- SmartTag options.

Figure 1. Escrow's Insert Field window The Buyer group is shown with a — next to it. The group has been
expanded to show the available SmartTags. Current Info has also
been expanded to show the available SmartTags it has available.

The + and — are toggles. CLIicK on the + to expand the selection and CLIcK on the — to collapse the
selection.

Another change for both the Document Administrator and the End User is the Insert Field window will
remain on the screen until you CLick the Cancel button. This will allow you to easily insert multiple fields
from any tab without having to open the dialog box again and again as in the previous versions of
Impact/SQL.

» When you CLick on the SmartTag tab the first time, it will jump up to the first item in the
list. You will need to scroll down in order to reselect your field or group. This is how
Microsoft Word operates when using a tree structure.

The other tabs on the Insert Field window operate as in previous versions of Impact/SQL.

USA Digital Solutions, Inc.
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Insert Field Window in aUser Document

Figure 2 shows how the Insert Field window will appear in the

User document. The Mobile Homes tab will only be present in
General | Buyers | Selers | Buyer Payofts | Seler payorfs  smetrag | the User Document if there is more than one mobile home
& Buyer (@ = associated with the file.

= Joyner Ir., Melvin C.
e Full Name

- Fixed Mame . .
= Heme + Uesting The SmartTag tab will show only the groups where there is data

nail Address

anaturs abave the lne present. In the escrow file associated with Figure 2, you can see
- anature below fhe ine there are three Buyers, one Seller, and three Lenders.

i Tax Identification Mumber
Current Info
--~Forwarding Info

e Yertura, Bl 5. The next level of the group will show actual database
s gy e v information. You can see the three buyers’ names, the lenders’
oy iz Coner Resty Holdngs, L names, etc. If you expand this level, you will see the various

- Wl raro s 2 SmartTag fields associated with the group.
[+ Realty Lenders, Inc ;I

S LY

If you CLICK once on the SmartTag, Impact/SQL will show you
the value stored in the database for that field in the lower left

mel@gmail, com

1D e eed || portion of the window (same as previous versions of
. — Impact/SQL). If you DousLE-CLICK or press ENTER on the
Figure 2. Insert Field window in the User Document SmartTag, it will be inserted into the User document at the

cursor’s location.

Impact/SQL will not ask for a Placeholder Token or any Prompt Text when inserting SmartTags into a
User Document. The Insert Fields dialog box will remain open on the screen until the End User CLICKS
Cancel or the [XI.

Placeholder Tokens

When you insert a SmartTag into a Master, you need to identify a Placeholder Token for that field. The
SmartTag, in general, refers to only one instance of the party. The Placeholder Token is how the
Document Administrator tells Impact/SQL to use another instance of the party. The Placeholder Token
can be any combination of letters and numbers. So, for example, if you want to use the Buyer’s current
work telephone number in a Master, your token could be Buyerl, BYR1, or even just 1. The 1 token
would then be used throughout the document every time you want to use database information for that
same Buyer.

If you need to refer to a different buyer in the same document, to distinguish between the two, you would
create a new Placeholder Token. Using the same token examples as above, this additional buyer could
use the token Buyer2, BYR2, or just 2 everywhere their information should be displayed in the document.

It should be noted here a numbering sequence, if any, you use with the Placeholder Token does not
correlate to the Position number of the party. In other words, the Placeholder Token, Buyerl, does not
refer to Buyer #1 in the Position list of Buyers. It refers to the Buyer the End User selected in the drop-
down when the document was created.

Naming Conventions For Placeholder Tokens

It is left entirely up to the Document Administrator as to how to use the Placeholder Tokens to identify
different parties in a document. You can use a simple numbering sequence such as 1, 2, 3, etc. You can
use whatever system works within your environment. A few caveats to keep in mind are:

e No spaces or special characters can be used in the Placeholder Token. The following
characters will be removed from the Placeholder Token name if used: “~!@#$%"&*()_-
+={}]|\:;"'<>,. and spaces

USA Digital Solutions, Inc.
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e Placeholder Tokens can be 35 characters in length but try to keep them as short as possible

(around 12 or less characters).

e Placeholder Tokens are replaced in User documents with a random sequence number.

e Be consistent in all your Masters. Use the same Placeholder Token scheme in all your
documents. It will make maintaining them a much simpler process.

USA Digital Solutions Library Placeholder Tokens

The table below displays the list of Placeholder Tokens that you can expect to find in a document created
by USA Digital Solutions. You may or may not follow the same convention. They are provided in case you

need to work with a Master from the DSI Library.

SmartTag Grouping

Placeholder Token

Buyer BUY1, BUYZ2, BUY3, etc.
Seller SELL1, SELL2, SELLS, etc.
Lender LEND1, LEND2, LENDS3, etc.

Listing Agent

LISTAL, LISTAZ, LISTAS, etc.

Selling Agent SELLAL, SELLA2, SELLAS, etc.
Other Agent OTHA1, OTHA2, OTHAS, etc.
Attorney ATTY1, ATTY2, ATTY3, etc.
Accommodator ACCM1, ACCM2, ACCMS, etc.
Other OTHP1, OTHP2, OTHP3, etc.
Property PROP1, PROP2, PROP3, etc.

Buyer Payoff

BYPO1, BYPO2, BYPO3, etc.

Seller Payoff

SLPO1, SLPO2, SLPOS, etc.

Mobile Homes

MH1, MH2, MH3, etc.

Prompt Text

Another element to the SmartTag is the Prompt Text. You can ask the End User a question that will help
them make the appropriate choice from the drop-down menu of parties or properties that are associated
with the file. If you use the Seller Full Name SmartTag in your document, you can have Impact/SQL ask
them when the document is created “Seller Used with this Deed?” The prompt can be anything that you
feel will help the End User make the correct decisions.

USA Digital Solutions, Inc.
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Prompt Text should not be longer than 45 characters long otherwise it will run to the drop-down field

associated with the SmartTag and be cut off.

What Triggers the Prompt Text to Display

You do not have to provide a prompt for every SmartTag you use in
a Master document. The Prompt Text will only appear when a one-
to-many situation exists. If we look at the Lender group in the
SmartTag tree (Figure 3), for each Lender there is only one Full
Name, one Attention To, one Addressl and so forth. When using
these SmartTags, you can type in a prompt for the first field in the
document using that Placeholder Token for a Lender. The rest of
the time you insert a SmartTag for that Lender’s Placeholder Token,
you can leave off the prompt. The user will not be shown it.

If you use a One-to-One type SmartTag again with a different
Placeholder Token, you will need to provide a new prompt for the
End User of the Master such as “ldentify the Second Lender”.

Figure 4 shows an example of a One-to-Many relationship
regarding the SmartTags. For each buyer there could many
different payoff entries. If you are creating a document where you
use the Placeholder Token BUY1, you will need to provide Prompt
Text to allow the End User to select which buyer to use with the
document. Then when you insert the buyer's payoff information
SmartTags, you will need to provide Prompt Text again because
there could be numerous payoffs. The End User needs to know
which one to use and the Prompt Text can help them make the
correct choices.

Inserting a SmartTag into the Master

The steps for inserting a SmartTag into your Master follow the
same procedure you used to insert a DDE field in previous
versions of Impact/SQL. In the Master, you position the cursor
where you want to use a field and CLick the Field button on the
Impact/SQL toolbar. The Insert Fields window appears on the
screen and you select the field you want and CLick the Insert
button.

Insert Field

Sellers | Buyer Payoffs | Seller Payoffs | M.Homes ~SmartTag I

4]

- Lender
Full Mame:
AttentionTa
Email Address
Address 1
Address 2

o tyddress City

- Address State

o Zip Code

-~ City,State Zip

- Home: Mumber

- ok Mumber

- Work Extension

- Fax Number

- Cell Humber

o Representing

- Reference Nurmber

-~ Loan humber

+ Loan Amount
i Eimmmrirn

=l

J

=l

I <<Lender.LoanTerms,IMAmount, M=

subl=DdeChan#l

cowt_|

Figure 3. One to One Relationship

Insert Field

Sellers | Buyet Pavoffs | seller Payoffs | M Homes  SmartTag I

Lo

- Buyer

---Seller

- Lender

Listing Agent
Selling Agent
-~ (ther Agent

- Skbarney

- Accommodator
e Other
~Property

0-E-(- - (-0 - - R

- Payoff To
- Bddress 1
ddress 2
ity State Zip
oan Mumber

e AOUNE
[ Payoff
[~ Mohile Home:

Insert I

Cancel

Figure 4. One to Many Relationship

A SmartTag field has an additional step before the field is inserted to the Master. You need to define a
Placeholder Token and provide the End User with Prompt Text to help them identify the proper party to
be used in the document. When you have a SmartTag in the Master, the End User will be presented with
the Data Selector dialog box when they create the document. In this dialog box, they select the correct
party for the document in a drop-down list. Once they identified all the parties to be used in the document

and CLick OK, the document is created.

1. Place the cursor at the location in the Master where a SmartTag is to be used.

2. CLick on the Field button on the Impact/SQL Toolbar.

3. CLick on the SmartTag tab.

> You may have to use the P-to scroll the tabs to the left in order to see the SmartTag tab.

USA Digital Solutions, Inc.
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SmartTags

10.

CLick on the SmartTag body area to activate it.
Selected Field: BuyerPayoff.Loanhumber. 77
CLick on the + next to the group you want to use. Placeholder Token: | |
Prompt Text: |
CLick on the SmartTag to be used. Conce
CLick on the Insert button. Figure 5. SmartTag Insert

» You can also DousLE-CLIck on the field and skip Step 7.

The SmartTag Insert dialog box appears on the screen (Figure 5). Type in your Placeholder
Token and press TAB.

Type the Prompt Text that should be shown to the End User for this field when the document is
created, if necessary.

CLicK the Insert button. Missing Data

» You can CLick the Cancel button to return to the Insert Missing Placehalder Token,
Field window without inserting this particular field.

» If you Cuick Insert and have not provided a Placeholder
Token, the error message shown in Figure 6 will appear Figure 6. Missing Placeholder
on the screen. CLick OK and type a Placeholder Token. Token Error

The Data Selector Dialog Box

If a document has a SmartTag field, Impact/SQL will display the Data Selector dialog box, shown in
Figure 7, when the document is first opened. This will happen in both the Master and the User versions of
the document. The dialog box will display each SmartTag’s Prompt Text along with a drop-down field
displaying the current values for the Escrow file. If you are viewing a Master, the drop-down menus will be
blank because there is no Escrow file associated with the document.

When the User document is created
In order ko prepare the document the system needs additional information. and the Data Se|eCt0r haS been f|”ed

Please make a selection for each categary below.

out, the End User will CLick the OK

Buyer

Property I

Seller associated with this Grant Deed? I

|»

button to proceed with the document
creation. At this point, Impact/SQL will
populate all the SmartTags with
F matching database information for the
parties and/or properties selected.

Led el

~ Impact/SQL will replace all Placeholder

Unused Field Options:
’7(" Change ko fill ins % Leave

Tokens with a random numbering
sequence. All identical Placeholder

Tokens will have the same sequence

Figure 7. The Data Selector Dialog Box number_ in  this _documenp This
numbering sequence is not an identifier

to the party chosen in the Data Selector. The next time you create the document, an entirely different
number will be used. The sequence is only used within the same document.

Figure 7 also shows an example of what occurs when you do not provide Prompt Text for a SmartTag. In
this example, a Property and Buyer SmartTag was used in the document without providing Prompt Text.

USA Digital Solutions, Inc.
Document Maintenance for SmartTags v1.00 Page 8 2/9/2011



SmartTags

Unused Field Options

This area of the Data Selector is for the End User to tell Impact/SQL how to treat the SmartTags when an
option is not selected from one of the drop-down fields.

The Change to fill ins radio button will remove the SmartTag field from the document and replace it with
a Fill-in ([ . If the Leave radio button is selected (the default), the SmartTag will remain in the
document so the information can be provided later.

» The X is disabled on this dialog box. CLick the OK button to close the window.

Unanswered Questions

If the End User does not answer all the Prompt Text before clicking the OK button and has the Unused
Field Options set to Leave, you can have the Data Selector shown on the screen again at a later time by
pressing CTRL-SHIFT-R. Only the Prompt Text that has not been answered will be shown in the Data
Selector.

Examining the SmartTag Field

The SmartTag will take on the same appearance in the Master that you have seen with the DDE fields.
The display text is shown within double angle brackets such as <<BuyerPayoff.LoanNumber>>. You can
RIGHT-CLICK on the SmartTag and choose Toggle Field Codes to display the detailed SmartTag
information. Below is that detail for the <<BuyerPayoff.LoanNumber>>:

{ DDE IMPACT SmartTag BuyerPayoff.LoanNumber.BUY1|Which Loan is being paid off? \*
charformat \t }

BuyerPayoff.LoanNumber is the name of the SmartTag being examined. BUY1 is the Placeholder
Token used in this particular instance. It is referring back to the BUY1 Placeholder Token used to identify
the name of the buyer. This way Impact/SQL can bring in the correct payoff data if there is more than one
buyer associated with the file.

The | separates the field name information from the Prompt Text. Which Loan is being paid off? Is the
Prompt Text for this SmartTag. This is what will be displayed when the User document is first created.

You can toggle the SmartTag field as shown above and edit the Placeholder Token and/or the Prompt
Text.

If you toggle the SmartTag in a User document and the Prompt Text has been answered in the Data
Selector, you will see the random sequence number that has replaced your Placeholder Token. Using the
example shown above, in the User document all BUY1 Placeholder Tokens will be replaced by the same
sequence number in this document.

{ DDE IMPACT SmartTag BuyerPayoff.LoanNumber.07F3CCD4-4C7C-43E1-B1A6-
005CEEDB2CB8|Which Loan is being paid off? \* charformat \t }

If this number is changed, the text from the database will disappear. The SmartTag will still be in the
document, but since Impact/SQL doesn’t recognize it, no data can be displayed. You can repair this
SmartTag by closing and reopening the document or just press CTRL-SHIFT-R. Impact/SQL will display
the Data Selector dialog box again and the Prompt Text can be answered once again.

USA Digital Solutions, Inc.
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Other Changes

Other Changes

There are a few more changes in Impact/SQL 7.6 that need to be mentioned briefly. Each one of these
topics will be covered in this area.

Fixed Name vs. Full Name

On the SmartTag tab in the Insert Field window, you will see three different options for displaying the
parties name in a document. They are a) Full Name, b) Fixed Name, and c) Fixed Name + Vesting. The
Fixed Name options will display the party’s name as First Middle Last. Full Name will be displayed as
Last, First Middle. The table below show how this will appear for Melvin C. Joyner, Jr.

SmartTag User Document View

Full Name Joyner, Jr., Melvin C.

Fixed Name Melvin C. Joyner, Jr.

Fixed Name + Vesting Melvin C. Joyner, Jr., an unmarried man

Secondary Escrow Officer

There are new DDE fields under the General Tab for displaying the Secondary Escrow Officer’s
information in documents. These are new to Impact/SQL v.7.6 so your Masters will have to be edited to
take advantage of these fields.

» The option to use Secondary Escrow Officers must be turned on in the Utilities Module in
order for the Impact/SQL user to enter this information for an Escrow File.

The new fields available to Masters are shown below

Document Text Field Name User Document View
Secondary Escrow Officer Name ESCDDE(465) Kate Longfellow

Secondary Escrow Officer Phone ESCDDE(466) (602) 234-3596

Secondary Escrow Officer Fax ESCDDE(467) (602) 234-9320

Secondary Escrow Officer Email ESCDDE(468) klongfellow@MyEscrow.com
Secondary Escrow Officer Initials ESCDDE(469) KL

Buyer and Seller Notary Blocks

On the Parties window for both Residential and Commercial files, you have the option to provide the text
that should be used for the notary block for the Buyers and the Sellers. There is one all the Buyers will
use and one all the Sellers will use. Each Buyer or Seller does not have their own block.

USA Digital Solutions, Inc.
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Other Changes

The End User will have the opportunity to type this information when the parties are entered into the file
or by editing either the Buyer parties or Sellers parties at any point in time. The notary block text can then
be brought into the document wherever the Document Administrator has placed one of the two new DDE
fields which contain this information.

Because the Notary Block text will be displayed on the User document via a field, the information can not
be edited directly on the document. The End User will have to return to the Parties window to make any
modifications. If the End User does make any changes to the Notary Block text while in the document, it
will remain until they save and close the document. When the document is opened again, the changes
will be gone.

There are two new DDE fields available to your documents. The <<Buyer Notary Block>> DDE field can
be found on the Buyers tab and the <<Seller Notary Block>> can be found on the Sellers tab on the
Insert Field window.

Document Text Field Name

Buyer Notary Block ESCDDE(462)

Seller Notary Block ESCDDE(463)

In the Buyer and/or Seller group on the Parties window,

e Twmree] | the End User clicks the Notary Block icon €% to open the
Notary Block window. The Buyer Notary Block is shown
Sr;?sonally known ko me [or proved tome an the basiz of satisfactom evidence] to be here |n Flgure 8 bUt the Se”er NOtary BIOCk WlndOW
the perzon(s) whose name(s] isdar subscribed behaves |n the same manner

On
i and for 2aid County and State, perzonally appeared

Underscores can be used to represent blank lines if need

be. No DDE or SmartTags fields can be used within this
= | Notary Block.

LCancel

Figure 8. Notary Block Window

If the text is entered with a hard return at the end of each
line, it will maintain the look entered here. If the text is
allowed to wrap at the end of each line, then the Notary Block text will take on the margins of the Master
document. To contain the width in those cases, you can place the DDE field inside a table cell.

If the Master documents contain Notary Blocks already, this will not override them. This information will
not be used unless the <<Buyer Notary Block>> and/or <<Seller Notary Block>> fields are in the
document.

Mobile Homes

The mobile home DDE fields were introduced in Impact/SQL 7.5 for Escrow documents. They used
comments to bring information from the database to the document. Several issues were identified with
these DDE fields and have been corrected. However, in Impact/SQL v.7.6, mobile home fields are now
also SmartTags.

All your existing Master documents that have Mobile Home fields will still function. USA Digital Solutions,
Inc. recommends you replace them, however, with the new SmartTags. These new fields are more
reliable and represent the way all fields will be in Impact/SQL in the future.
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Other Changes

Figure 9 shows the Insert Field window in a User document with
the Mobile Home SmartTags displayed. Because this is a User
document, the address of the mobile home is displayed. There
are fields for up to four units for each address.

The SmartTags for mobile home are inserted to the Master the
same as any other SmartTag. You will need to have a
Placeholder Token for each instance of the mobile home group
to be used in the document. You'll also have to provide your End
User with a prompt to help them identify which mobile home to
use with the document on the first field you insert in the
document.

Effects on AutoText and AutoCorrect

If you as the Document Administrator use AutoText to save
frequently used blocks of text and/or fields as AutoText, you can
continue to do so with SmartTags. You can store SmartTags with

Sellers | EBuyer Payoffs I Seller Payoffs | M.Homes SmarkTag I 4] »
=)+~ Mobile Home: (1) -]

[=)--5185 W, Shariyn Hil Circle - MobilsHome 1
---Decal License

- Trade Name

- Make and Model
- Manufacture Date
- Firsk Sale Date

- Manufacture [0
v Dealer License

- Registration Date
v HCD Address 1

~-HCD City, State Zip
- Situs Ciky

--Situs Skate

-Situs Zip Code

Manufacturer Mame:

Tax Type Code

HCD Address 2

Unit 1

P mewiol b

=l

o |

Figure 9. Mohile Home SmartTags

the most common Placeholder Token and Prompt Text already prepared. The User documents will not

have a seamless way to accomplish the same thing however.

If they insert a SmartTag into a document with a Placeholder Token, no data will be displayed because
Impact/SQL has not had the opportunity to exchange the Placeholder Token for the randomly generated
sequence number found in User documents. The End User will have to add the step of pressing CTRL-

SHIFT-R to their routine in order to see the database information.
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Working With Legal Descriptions

Working With Legal Descriptions

Inserting a legal description into your Masters has not changed in Impact/SQL 7.6 for the Document
Administrator. You still specify where you want the legal description to be printed using Microsoft Word’s
INCLUDETEXT field. This field can be contained within a table cell or just part of the body of the
document.

The differences for legal descriptions will all be apparent on the User documents. Since you could have
numerous properties associated with a Commercial file, there could be numerous legal descriptions.
Residential files will continue to have only one legal description.

It is important the Document Administrator is aware of how the End User will see the documents as
opposed to how they view them. There can only be one legal description that appears in a User
document. The Document Administrator should keep this in mind when creating Masters so they can
provide the End User with clear and concise prompts when necessary to help them pick the correct
options.

Editing the Legal Description

The End User will use the same steps to create a legal description for a multiple property file as they do
for a single property file. If the file has only one property, the End User will not see any differences from
previous versions of Impact/SQL. If the file has multiple properties, the End User will see the Property
Selector dialog box (Figure 10) on the screen after choosing Edit > Legal Descriptions from the
Impact/SQL desktop.

Below are the steps the End User will perform to edit a legal description when there are multiple
properties in the file.

1. Choose Edit > Legal Descriptions.

Select the property that vou would like ta edit the legal description an.

. Property &ddress ]
2. CLick on the property address for which you need i ive_Suite 100 Phoeris 2 5129
to create a legal description. TUETSH. 25t ook 58 Peapi A S50

5593939 N. 26th. Ave.. Phoenix, &2 85029

3. CLick the OK button.

» Cuick the Cancel button to return to
the Impact/SQL Desktop. Figure 10. Property Selector Dialog Box

-
4, Type the legal description and CLick the L4 icon when completed.

Creating User Documents That Contain a Legal Description

When the End User picks a document from the Document Menu and it contains the INCLUDETEXT field
for the legal description, Impact/SQL will behave in one of two ways depending upon the number of
properties associated with the file. If there is only one property, the End User will not see anything
different than what occurred in previous versions of Impact/SQL. If the file has multiple properties, the
End User will see the Select Legal

Description dialog box.
L ~]

" 10835 N, 25th, Ave.,
10835 M. 25th, Ave.,

When the User document is created, '

Impact/SQL will display the Select Legal
Description dialog box on the screen.
The End User highlights the property to

Su A
Suibe 225, Phoenix, AZ 85029

Figure 11. Select Legal Description Dialog Box
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Working With Legal Descriptions

be associated with the document and then CLicks the OK button.

All the DDE fields in the document will display
information associated with this property address.

@ This docurment requires a legal description, but the legal hasn't been created yet,

If the End User CLICKS on the Cancel button instead
of choosing a property and the Master contains a
legal description, they will see the warning message

Figure 12. Missing Legal Description Warning shown in Figure 12.

Creating User Documents Without a Legal Description

The Select Legal Description dialog box will only appear on the screen when the User document is
created and the Master document contains the INCLUDETEXT field to bring in the legal description. If this
element is missing from the Master document and any property fields are used, Impact/SQL will use the
information associated with the first property if multiple properties are present in the Escrow file.

If there is only one property present in the Escrow file and the Master doesn’t contain a legal description
but uses the other property fields, the End User will not see any difference in how the document is
created from the way it was created in previous version of Impact/SQL.
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